
3Maintaining a Database

• Add, change, and delete records

• Search for records

• Filter records

• Update a table design

• Format a datasheet

• Use action queries to update records

• Specify validation rules, default 
values, and formats

• Create and use single-valued and 
multivalued Lookup fi elds

• Specify referential integrity

• Use a subdatasheet

• Sort records

Objectives
You will have mastered the material in this chapter when you can:
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Introduction
Once a database has been created and loaded with data, it must be maintained. Maintaining 
the database means modifying the data to keep it up-to-date, such as adding new records, 
changing the data for existing records, and deleting records. Updating can include mass 
updates or mass deletions; that is, updates to, or deletions of, many records at the same time.

Maintenance of a database can also involve the need to restructure the database 
periodically; that is, to change the database structure. Restructuring can include adding 
new fi elds — including both Lookup and multivalued fi elds — to a table, changing the 
characteristics of existing fi elds, and removing existing fi elds. It also includes the creation of 
validation rules and referential integrity. Validation rules ensure validity of the data in the 
database, while referential integrity ensures the validity of the relationships. 

Maintaining a database also can include fi ltering records, a process that ensures that 
only the records that satisfy some criterion appear when viewing and updating the data in 
a table. Changing the appearance of a datasheet is a maintenance activity. Finally, backing 
up the database as well as compacting and repairing a database are database maintenance 
tasks as well.

Project — Maintaining a Database
JSP Recruiters faces the task of keeping its database up-to-date. As the agency takes on new 
clients and recruiters, it will need to add new records, make changes to existing records, and 
delete records. JSP managers have found they must change the structure of the database to 
categorize the clients by type. They will do this by adding a Client Type fi eld to the Client 
table. They also want to track the specialties that are of interest to clients. They will do so 
by adding a Specialties Needed fi eld to the Client table. Because clients may need more than 
one specialty, this fi eld will be a multivalued fi eld. Along with these changes, JSP staff want 
to change the appearance of a datasheet when displaying data.

JSP would like the ability to make mass updates, that is, to update or delete 
many records in a single operation. They want rules that make sure users can enter 
only valid data into the database, and they want to ensure that it is not possible for the 
database to contain a client who is not associated with a specifi c recruiter. Finally, they 
want to improve the effi ciency of certain types of processing, specifi cally sorting and 
retrieving data. 
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Figure 3–1 summarizes some of the various types of activities involved in maintaining 
the JSP Recruiters database.

Backup a databaseCompact and repair
a database

Add, change, and
delete records

Search for records

Filter records

Change the structure
of a table

Create single-
valued and multivalued

Lookup fields

Change the appearance
of a datasheet

Use update and
delete queries

Create validation rules

Specify default values

Specify relationships

Use subdatasheets

Sort records

Figure 3–1

Overview
As you read through this chapter, you will learn how to maintain a database by 

performing these general tasks: 

• Add, change, and delete records.
• Filter records so that only those records that satisfy some criterion appear in a 

datasheet or form.
• Change the structure of a table.
• Make mass changes to a table.
• Create validation rules to ensure that the database contains only valid data.
• Change the appearance of a datasheet.
• Enforce relationships by creating referential integrity.
• Order records.
• Perform special database operations such as backing up a database and compacting a 

database.

C6165_ACC_03.4c.indd   139C6165_ACC_03.4c.indd   139 3/7/07   9:50:25 AM3/7/07   9:50:25 AM



AC 140   Access Chapter 3    Maintaining a Database

Starting Access
If you are using a computer to step through the project in this chapter and you want 
your screen to match the fi gures in this book, you should change your screen’s resolu-
tion to 1024 � 768. For information about how to change a computer’s resolution, 
read Appendix E.

Database Maintenance Guidelines

1. Determine when it is necessary to add, change, or delete records in a database. Decide 
when updates are necessary. Also determine whether the updates are to be made to 
individual records or whether mass updates would be more effi cient. For example, if a 
state changes an area code, a mass update would be more effi cient.

2. Determine whether you should fi lter records. For each situation where a user will be 
working with a table in the database, examine whether it might be desirable to have the 
records fi ltered, that is, have only those records that satisfy some criterion appear. For 
example, if a user only wants to make changes to clients in a particular city, it would be 
easier to view only those records rather than all the records in the table.

3. Determine whether additional fi elds are necessary or whether existing fi elds should be 
deleted. Have there been any changes to the initial requirements that would require the 
addition of a fi eld (or fi elds) to one of the tables? If so, you will need to add the fi eld to 
the appropriate table. Also, now that the database has been in operation for a period 
of time, determine whether all the fi elds actually are being used. If some fi elds are not 
in use, verify that they are, in fact, no longer needed. If so, you can delete the fi eld from 
the table.

4. Determine whether validation rules, default values, and formats are necessary. Can you 
improve the accuracy of the data entry process by enforcing data validation? What val-
ues are allowed for a particular fi eld? Are there some fi elds in which one particular value 
is used more than another? You can control the values that are entered in a fi eld by 
modifying the table design to include default values, formats, and validation rules.

5. Determine whether changes to the format of a datasheet are desirable. Can you im-
prove the appearance of the Datasheet view of your tables? Once you have decided on 
a particular appearance, it is a good idea to be consistent throughout all your tables 
except in special circumstances.

6. Identify related tables in order to implement relationships between the tables. Examine 
the database design you created earlier to identify related tables. For each pair of re-
lated tables, you will need to make decisions about the implementation of the relation-
ship between the tables.

When necessary, more specifi c details concerning the above decisions and/or actions 
are presented at appropriate points in the chapter. The chapter also will identify the use of 
these guidelines in database maintenance tasks such as those shown in Figure 3–1 on the 
previous page.

Plan
Ahead
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To Start Access

The following steps, which assume Windows is running, start Access.

1  Click the Start button on the Windows taskbar to display the Start menu.

2  Point to All Programs on the Start menu to display the All Programs submenu and then 
point to Microsoft Offi ce on the All Programs submenu to display the Microsoft Offi ce 
submenu.

3  Click Microsoft Offi ce Access 2007 on the Microsoft Offi ce submenu to start Access and 
display the Getting Started with Microsoft Offi ce Access window.

4  If the Access window is not maximized, click the Maximize button on its title bar to 
maximize the window.

To Open a Database

In Chapter 1, you created your database on a USB fl ash drive using the fi le name, 
JSP Recruiters. There are two ways to open the fi le containing your database. If the fi le 
you created appears in the Recent Documents list, you can click it to open the fi le. If not, 
you can use the More button to open the fi le. The following steps use the More button to 
open the JSP Recruiters database from the USB fl ash drive.  

1  With your USB fl ash drive connected to one of the computer’s USB ports, click the More 
button to display the Open dialog box.

2  If necessary, click the Look in box arrow and then click UDISK 2.0 (E:) to select the USB fl ash 
drive, in the Look in list as the new open location. (Your drive letter might be different.)

3  Click JSP Recruiters to select the fi le name.

4  Click the Open button to open the database.

5  If a Security Warning appears, click the Options button to display the Microsoft Offi ce 
Security Options dialog box. 

6  Click the Enable this content option button.

7  Click the OK button to enable the content.

Updating Records
Keeping the data in a database up-to-date requires updating records in three ways: adding 
new records, changing the data in existing records, and deleting existing records.

Adding Records
In Chapter 1, you added records to a database using Datasheet view; that is, as you 

added records, the records appeared on the screen in a datasheet. The data looked like a 
table. When you need to add additional records, you can use the same techniques.

In Chapter 1, you used a split form to view records. The split form contained both a 
form and a datasheet. You can use either portion to add records. You also can use a simple 
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1
• Show the Navigation pane if it is 

currently hidden.

• If necessary, click the Client table 
in the Navigation pane to select it.

• Click Create on the Ribbon to 
display the Create tab (Figure 3–2).

form, that is, a form that does not contain a datasheet. Whether you use a simple form 
or the form portion of a split form, you can use the form to update the table. To add new 
records, change existing records, or delete records, you use the same techniques you used 
in Datasheet view. The following steps create a simple form and then add a record to the 
Client table using the form.

To Create a Simple Form

Rather than using a split form, you may wish just to view the data in a form without also having a datasheet on 
the screen. If you already have created such a form, you can open it. If not, you can create a simple form to use. The 
following steps create a simple form.

Figure 3–2

Navigation pane

Form 
button

Create tab

Client 
table
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2
• Click the Form button 

on the Create tab to 
create a simple form 
(Figure 3–3).

How can I tell which 
view of the form 
is currently on the 
screen? 

Point to the button 
that is highlighted in 
the lower-right cor-
ner of the screen. The 
ScreenTip indicates 
the current view. 
At the present time, 
the form appears in 
Layout view. 

Which view should I 
use if I want to enter 
records? 

Form view. 

Q
&

A
Q

&
A
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Figure 3–3

form is for 
Client table

form 
created

form appears in Layout view, 
in which you can change the 
layout of the form

Form View 
button

3
• Click the Form View button to 

display the form in Form view 
(Figure 3–4).

Could I use the View button to 
display the form in Form view? 

Yes. Click the arrow at the 
bottom of the button and then 
click Form View. 

I Experiment

• Click the various navigation 
buttons (First record, Next 
record, Previous record, and 
Last record) to see each 
button’s effect. Click the 
Current Record box, change 
the record number, and press 
the ENTER key to see how to 
move to a specifi c record. 

Q
&

A

Figure 3–4

New (blank) 
record button

Last record  
button

Current 
Record box Next record  

button

First record 
button

Previous 
record button
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To Use a Form to Add Records

Once a form is open in Form view you can add records using the same techniques you used to add records in 
Datasheet view. The following steps use the form just created to add records.

1
• Click the New (blank) record but-

ton on the Navigation bar to enter 
a new record, and then type the 
data for the new record as shown 
in Figure 3–5. Press the TAB key 
after typing the data in each fi eld, 
except after typing the data for 
the fi nal fi eld (Recruiter Number).

Close ‘Client’ 
button

data for 
new record

Figure 3–5

2
• Press the TAB key to complete the 

entry of the record.

• Click the Close ‘Client’ button to 
close the Client form.

• Click the No button when asked if 
you want to save your changes.

Why not save the form? 

If you wish to use this form 
frequently in the future, you 
would probably save it. It is very 
easy to re-create the form 
whenever you need it, however. 

Other Ways

1. Click New button on 
Ribbon

2. Press CTRL+PLUS SIGN (+)

Q
&

A
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To Search for a Record

In the database environment, searching means looking for records that satisfy some criteria. Looking for the 
client whose number is MH56 is an example of searching. The queries in Chapter 2 also were examples of searching. 
Access had to locate those records that satisfi ed the criteria.

A need for searching also exists when using Form view or Datasheet view. To update client MH56, for 
example, fi rst you need to fi nd the client. 

The following steps show how to search for the client whose number is MH56.

1
• Right-click Client Form in the 

Navigation pane and click Open 
on the shortcut menu to open the 
form in Form view.

• Hide the Navigation pane 
(Figure 3–6).

Which command on the shortcut 
menu gives me Form view? I see 
both Layout view and Design 
view, but no option for Form view. 

The Open command opens the 
form in Form view. 

Figure 3–6

Find 
button

click Replace button 
to change data

Client Number 
fi eld selected

Q
&

A

split form
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2
• Click the Find 

button on the Home 
tab to display the 
Find and Replace 
dialog box.

• Type MH56 in the 
Find What text box.

• Click the Find Next 
button in the Find 
and Replace dialog 
box to fi nd client 
MH56 (Figure 3–7).

Can I also fi nd 
records in Datasheet 
view or in Form view? 

Yes. You use the 
same process to fi nd 
records whether 
you are viewing the 
data with split form, 
in Datasheet view, 
or in Form view. 

I Experiment

• Find records using 
other client num-
bers. Try to fi nd a 
record using a client 
number that does not 
exist. Click in a different fi eld and try to fi nd records based on the value in that fi eld. Try to 
use wildcards just as you did in queries. When done, once again locate client MH56. 

3
• Click the Cancel button in the Find and Replace dialog box to remove the dialog box from 

the screen.

Why does the button in the dialog box read Find Next rather than simply Find? 

In some cases, after locating a record that satisfi es a criterion, you might need to fi nd the 
next record that satisfi es the same criterion. For example, if you just found the fi rst client 
whose recruiter number is 24, you then may want to fi nd the second such client, then the 
third, and so on. To do so, click the Find Next button. You will not need to retype the value 
each time. 

Can I replace one value with another using this dialog box? 

Yes. Either click the Replace button on the Ribbon or the Replace tab in the Find and Replace 
dialog box. You then can enter both the value to fi nd and the replacement value. 

Figure 3–7

Cancel 
button

Find Next 
button

Search Fields As Formatted 
check box currently 
checked so formatting will 
be considered in search

Match Case check 
box unchecked so 
search will not be 
case sensitive

scope of the search 
(all records)

value for which 
to search

client MH56 found

Find and Replace 
dialog box

click Replace tab 
to change data

fi eld in which to search 
(Client Number)

portion that must 
match (Whole Field)

Other Ways

1. Press CTRL+F

Q
&

A
Q

&
A

Q
&

A
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To Update the Contents of a Record

After locating the record to be changed, select the fi eld to be changed by clicking the fi eld. You also can press 
the TAB key repeatedly. Then make the appropriate changes. (Clicking the fi eld automatically produces an insertion 
point. If you use the TAB key, you will need to press F2 to produce an insertion point.)

The following step uses Form view to change the name of client MH56 from Maun Hospital to Munn Hospital 
by deleting the letters au and then inserting the letters un after the letter M.

1
• Click in the Client Name fi eld in the 

datasheet for client MH56 after the 
letter M to select the fi eld.

• Press the DELETE key twice to 
delete the letters au.

• Type the letters un after the 
letter M.

• Press the TAB key to complete the 
change and move to the next fi eld 
(Figure 3–8).

Could I have changed the contents 
of the fi eld in the form? 

Yes. You fi rst will need to ensure 
the record to be changed appears 
in the form. You can then change 
the value just as in the datasheet. 

Do I need to save my change? 

No. Once you move to another 
record or close this table, the 
change to the name will become 
permanent. 

Figure 3–8

name 
changed 

name change 
refl ected in 
datasheet

Q
&

A
Q

&
A
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To Delete a Record

When records no longer are needed, delete the records (remove them) from the table. If client EA45 no 
longer is served by JSP Recruiters and its fi nal payment is made, the record can be deleted. The following steps 
delete client EA45.

1
• With the Client Form open, click 

the record selector in the data-
sheet (the small box that appears 
to the left of the fi rst fi eld) of 
the record on which the client 
number is EA45 (Figure 3–9).

That technique works in the data-
sheet portion. How do I select the 
record in the form portion? 

With the desired record appearing 
in the form, click the record 
selector (the triangle in front 
of the record) to select the 
entire record. 

Figure 3–9

record to 
be deleted

record selector 
on form  

record selector  
in datasheet

2
• Press the DELETE key to delete the 

record (Figure 3–10).

3
• Click the Yes button to complete 

the deletion. 

• Close the Client Form by clicking 
the Close ‘Client Form’ button.

Figure 3–10

message indicates 
you are about to 
delete 1 record

No buttonYes button

Microsoft Offi ce 
Access dialog box

Other Ways

1. Click Delete button on 
Ribbon

Q
&

A
AC 148   Access Chapter 3    Maintaining a Database

Filtering Records
You can use the Find button in either Datasheet view or Form view to locate a record 
quickly that satisfi es some criterion (for example, the client number is MH56). All records 
appear, however, not just the record or records that satisfy the criterion. To have only the 
record or records that satisfy the criterion appear, use a fi lter. Four types of fi lters are 
available: Filter By Selection, Common Filters, Filter By Form, and Advanced Filter/Sort. 
You can use a fi lter in either Datasheet view or Form view.
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Determine whether you should fi lter records. 
If you determine that it is desirable to have only those records that satisfy some criterion 
appear, you have two choices. You can create a query or create a fi lter. The following 
guidelines apply to this decision.

1. If you think that you frequently will want to display records that satisfy precisely this same 
criterion, you should consider creating a query whose results only contain the records that 
satisfy the criterion. To display those records in the future, simply open the query.

2. If you are viewing data in a datasheet or form and decide you want to restrict the 
records to be included, it is easier to create a fi lter than create a query. You can create 
and use the fi lter while you are viewing the data.  

3. If you have created a fi lter that you would like to be able to use again in the future, you 
can save the fi lter as a query.

If you have decided that it is appropriate to use a fi lter, you need to decide which type 
of fi lter to use.

1. If your criterion for fi ltering is that the value in a particular fi eld matches or does not 
match a certain specifi c value, you can use Filter By Selection.

2. If your criterion only involves a single fi eld but is more complex, for example, that the 
value in the fi eld begins with a certain collection of letters, you can use a Common Filter.

3. If your criterion involves more than one fi eld, use Filter By Form.

4. If your criterion involves more than a single And or Or, or if it involves sorting, you will 
probably fi nd it simpler to use Advanced Filter/Sort.

Plan 
Ahead

To Use Filter By Selection

The simplest type of fi lter is called Filter By Selection. To use Filter By Selection, you give Access an 
example of the data you want by selecting the data within the table. You then choose the option you want on the 
Selection menu. If you have determined that you only want to display those clients located in Berridge, Filter 
By Selection is appropriate. The following steps use Filter By Selection in Datasheet view to display only the records 
for clients in Berridge.

1
• Open the Client form and hide the 

Navigation pane.

• Click the City fi eld on the fi rst 
record in the datasheet portion of 
the form to select Berridge as the 
city (Figure 3–11).

Could I have selected the City fi eld 
on the fourth record, which is also 
Berridge? 

Yes. It does not matter which 
record you select as long as the 
city is Berridge. 

Figure 3–11

City fi eld on 
fi rst record

Selection 
button

Q
&

A
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2
• Click the Selection button on the 

Home tab to display the Selection 
menu (Figure 3–12).

Figure 3–12

Selection 
button menu

include only records 
where the city does not 
contain Berridge

include only records 
where the city is not 
equal to Berridge

include only records where 
the city contains Berridge

include only records 
where the city is 
equal to Berridge
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3
• Click Equals “Berridge” to select 

only those clients whose city is 
Berridge (Figure 3–13).

Can I also fi lter in Datasheet view 
or in Form view? 

Yes. Filtering works the same 
whether you are viewing the data 
with split form, in Datasheet view, 
or in Form view. 

I Experiment

• Try each of the other values in 
the Selection menu to see their 
effect. When done, once again 
select those clients whose city is 
Berridge. 

Toggle Filter 
button

only clients whose city 
is Berridge appear

data is fi ltered

only two clients 
included

Q
&

A

Figure 3–13
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To Toggle a Filter

The following step toggles the fi lter to redisplay all records. 

1
• Click the Toggle Filter button 

on the Home tab to toggle the 
fi lter and redisplay all records 
(Figure 3–14).

Does that action clear the fi lter? 

No. The fi lter is still in place. If 
you click the Toggle Filter button 
a second time, you again will see 
only the fi ltered records. 

Figure 3–14

data is not fi ltered

Q
&

A

TO CLEAR A FILTER

Once you have fi nished using a fi lter, you can clear the fi lter. After doing so, you 
no longer will be able to use the fi lter by pressing the Toggle Filter button. To clear a 
fi lter, you use the following steps.
1. Click the Advanced button on the Home tab.
2. Click Clear All Filters on the Advanced menu.

all records once 
again appear

Using Wildcards in 
Filters
Both the question mark 
(?) and the asterisk (*) 
wildcards can be used 
in fi lters created using 
Advanced Filter/Sort.

B
T
W
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To Use a Common Filter 

You can fi lter individual fi elds by clicking the arrow to the right of the fi eld name and using a Common Filter. 
If you have determined you want to include those clients whose city begins with Ber, Filter By Selection would not 
be appropriate. You would need to use a Common Filter. The following steps use a common fi lter to include only 
those clients whose city begins with Ber.

1
• Be sure the Home tab is selected.

• Click the City arrow to display the 
common fi lter menu.

• Point to the Text Filters command 
to display the custom text fi lters 
(Figure 3–15).

I selected the City fi eld and then 
clicked the Filter button on the 
Home tab. My screen looks the 
same. Is this right? 

Yes. That is another legitimate way 
to display the common fi lter menu. 

Figure 3–15

clear any existing fi lter 
for this fi eld (currently 
there is none)

Begins 
With fi lter

display custom 
text fi lters

check box to select 
or deselect all values

custom text fi lters

check boxes to 
include specifi c values

sort the data 
in the column

City arrow

Q
&

A

2
• Click Begins With to display the 

Custom Filter dialog box.

• Type Ber as the City begins with 
value (Figure 3–16).

If I wanted certain cities included, 
could I use the check boxes? 

Yes. Be sure the cities you want are 
the only ones checked. One way 
to do this is to click the Select All 
check box to remove all the check 
marks and then click the check 
boxes for the cities you want to 
include. Another way is to clear the 
check boxes for the cities you don’t 
want. Use whichever technique 
you fi nd more convenient. 

I Experiment

• Try other options in the Common 
Filter menu to see their effect. 
When done, once again select 
those clients whose city begins 
with Ber. 

begins with 
value (Ber)

Custom Filter 
dialog box

OK button

Figure 3–16

Q
&

A
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3
• Click the OK button to fi lter the 

records (Figure 3–17). (Your order 
may be different.)

Can I use the same technique in 
Form view? 

In Form view, you would need to 
click the fi eld and then click the 
Filter button to display the 
Common Filter menu. The rest of 
the process would be the same. 

4
• Click the Toggle Filter button on 

the Home tab to toggle the fi lter 
and redisplay all records.

Figure 3–17

Q
&

A

To Use Filter By Form 

Filter By Selection is a quick and easy way to fi lter by the value in a single fi eld. For more complex criteria, 
however, it is not appropriate. For example, if you determined you only wanted those clients whose postal code is 
80330 and whose amount paid is 0, you could not use either the Filter by Selection or the Common Filter processes. 
Rather, you would use Filter By Form. The following steps use Filter By Form to restrict the records that appear.

1
• Click the Advanced button on the 

Home tab to display the Advanced 
menu (Figure 3–18).

Figure 3–18

Filter By Form 
command

Clear All Filters 
command

Advanced button

Advanced menu

Toggle Filter 
button

only clients whose 
city begins with 
Ber are included
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2
• Click Clear All Filters on the 

Advanced menu to clear the 
existing fi lter.

• Click the Advanced button on the 
Home tab to display the Advanced 
menu a second time.

• Click Filter By Form on the 
Advanced menu.

• Click the Postal Code fi eld, click 
the arrow that appears, and then 
click 80330. 

• Click the Amount Paid fi eld, click 
the arrow that appears, and then 
click 0 (Figure 3–19).

Is there any difference in the 
process if I am viewing a table 
in Datasheet view rather than in 
Form view or in a split form? 

In Datasheet view, you will 
make your entries in a datasheet 
rather than a form. Otherwise, 
the process is the same. 

• Click the Toggle Filter button on 
the Home tab to apply the fi lter 
(Figure 3–20).

I Experiment

• Select Filter By Form again and 
enter different criteria. In each 
case, toggle the fi lter to see the 
effect of your selection. When 
done, once again select those 
clients whose postal code is 80330 
and whose amount paid is 0. 

Figure 3–19

Toggle Filter 
button

value for 
Amount Paid

value for 
Postal Code

Or tab allows you to enter 
another criterion to be 
combined with original 
criterion using Or

Amount Paid 
box arrow

Q
&

A

Figure 3–20

only record 
that is included

Postal Code 
is 80330 Amount Paid 

is $0.00
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To Use Advanced Filter/Sort

In some cases, your criteria may be too complex even for Filter By Form. You might decide you want to 
include any client for which the postal code is 80330 and the amount paid is $0. You also may want to include any 
client whose amount paid is greater than $20,000, no matter where the client is located. Further, you might want to 
have the results sorted by name. To fi lter records using complex criteria, you need to use Advanced Filter/Sort as in 
the following steps.

1
• Click the Advanced button on the 

Home tab to display the Advanced 
menu, and then click Clear All 
Filters on the Advanced menu to 
clear the existing fi lter.

• Click the Advanced button on the 
Home tab to display the Advanced 
menu a second time.

• Click Advanced Filter/Sort on the 
Advanced menu.

• Expand the size of the fi eld list 
so all the fi elds in the Client 
Table appear.

• Include the Client Number fi eld and 
select Ascending as the sort order.

• Include the Postal Code fi eld and 
enter 80330 as the criterion.

• Include the Amount Paid fi eld 
and enter 0 as the criterion in  
the Criteria row and >20000 
as the criterion in the Or row 
(Figure 3–21).

criterion for 
Amount Paid fi eld

Client Name fi eld

Toggle Filter button

Client Form tab

Postal Code fi eld
Amount Paid fi eld

criterion for 
Postal Code fi eld

sort order for 
Client Name fi eld

Figure 3–21
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2
• Click the Toggle Filter button on 

the Home tab to toggle the fi lter 
and view the results. Click the 
Client Form tab to view the Client 
table (Figure 3–22).

I Experiment

• Select Advanced Filter/Sort again 
and enter different sorting op-
tions and criteria. In each case, 
toggle the fi lter to see the effect 
of your selection. When done, 
change back to the sorting options 
and criteria you entered in Step 1. 

3
• Click Clear All Filters on the 

Advanced menu. 

• Close the Client Form.

Figure 3–22

fi ltered 
records

Filters and Queries
Filters and queries are related in three ways. 

1. You can apply a fi lter to the results of a query just as you can apply a fi lter to a table. 
2. When you have created a fi lter using either Filter By Form or Advanced Filter/

Sort, you can save the fi lter settings as a query by using the Save As Query 
command on the Advanced menu.

3. You can restore fi lter settings that you previously saved in a query by using the 
Load From Query command on the Advanced menu.

Changing the Database Structure
When you initially create a database, you defi ne its structure; that is, you assign names 
and types to all the fi elds. In many cases, the structure you fi rst defi ne will not continue to 
be appropriate as you use the database. 

Perhaps a fi eld currently in the table no longer is necessary. If no one ever uses a 
particular fi eld, it is not needed in the table. Because it is occupying space and serving no 
useful purpose, you should remove it from the table. You also would need to delete the 
fi eld from any forms, reports, or queries that include it.

More commonly, an organization will fi nd that it needs to maintain additional 
information that was not anticipated at the time the database was fi rst designed. The 
organization’s own requirements may have changed. In addition, outside regulations that 

Moving a Field in a 
Table Structure
If you add a fi eld to a 
table and later realize 
the fi eld is in the wrong 
location, you can move 
the fi eld. To do so, click 
the row selector for the 
fi eld and then drag the 
fi eld to the new location.

B
T
W
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the organization must satisfy may change as well. In either case, the organization must add 
additional fi elds to an existing table. 

To make any of these changes, you fi rst must open the table in Design view.

TO DELETE A FIELD

If a fi eld in one of your tables no longer is needed; for example, it serves no useful 
purpose or it may have been included by mistake, you should delete the fi eld. To delete a 
fi eld you would use the following steps.
1. Open the table in Design view.
2. Click the row selector for the fi eld to be deleted. 
3. Press the DELETE key. 
4. When Access displays the dialog box requesting confi rmation that you want to delete 

the fi eld, click the Yes button.

To Add a New Field 

You can add fi elds to a table in a database. JSP Recruiters has decided that it needs to categorize its clients. 
To do so requires an additional fi eld, Client Type. The possible values for Client Type are MED (which indicates 
the client is a medical institution), DNT (which indicates the client is a dental organization), or LAB (which 
indicates the client is a lab). The following steps add the Client Type to the Client table immediately after the 
Postal Code fi eld.

1
• Show the Navigation pane, and 

then right-click the Client table to 
display a shortcut menu.

• Click Design View on the shortcut 
menu to open the Client table in 
Design view.

• Click the row selector for the 
Amount Paid fi eld, and then press 
the INSERT key to insert a blank 
row above the Amount Paid row 
(Figure 3–23).

2
• Click the Field Name column for 

the new fi eld. If necessary, erase 
any text that appears.

• Type Client Type as the fi eld 
name and then press the TAB key.

Figure 3–23

row selector

space for 
new fi eld

Client table open 
in Design view

Other Ways

1. Click Insert Rows button 
on Ribbon
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To Create a Lookup Field

Because there are only three possible values for the Client Type fi eld, you should make it easy for users to 
enter the appropriate value. A Lookup fi eld allows the user to select from a list of values.

The following steps make the Client Type fi eld a Lookup fi eld.

1
• If necessary, click the Data Type 

column for the Client Type fi eld, 
and then click the arrow to display 
the menu of available data types 
(Figure 3–24).

Figure 3–24

Lookup 
Wizard

Data Type 
arrow

menu of available 
data types

data type 
is TextClient Type fi eld

AC 158   Access Chapter 3    Maintaining a Database

2
• Click Lookup Wizard, and then 

click the ‘I will type in the values 
that I want.’ option button to 
indicate that you will type in the 
values (Figure 3–25).

When would I use the other 
option button? 

You would use the other option 
button if the data to be entered 
in this fi eld is found in another 
table or query. 

Figure 3–25

Lookup Wizard 
dialog box

I will type in the values that 
I want. option button

Next button

description 
of wizard

Q
&

A
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3
• Click the Next button to display 

the next Lookup Wizard screen 
(Figure 3–26).

Figure 3–26

position to 
enter values

description 
of this step 
in the wizard

4
• Click the fi rst row of the table 

(below Col1), and then type MED as 
the value in the fi rst row. 

• Press the DOWN ARROW key, and 
then type DNT as the value in the 
second row. 

• Press the DOWN ARROW key, and 
then type LAB as the value in the 
third row (Figure 3–27). 

Figure 3–27

Next button

values entered
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To Add a Multivalued Field 

Normally, fi elds contain only a single value. In Access 2007 it is possible to have 
multivalued fi elds, that is, fi elds that can contain more than one value. JSP Recruiters 
wants to use such a fi eld to store the abbreviations of all the specialties their clients need 
(see Table 3–1 for the specialty abbreviations and descriptions). Unlike the Client Type, 
where each client only had one type, clients can require multiple specialty descriptions. 

Table 3–1 Specialty Abbreviations and Descriptions

Specialty 
Abbreviation Description

CLS Clinical Laboratory Specialist

CNA Certifi ed Nursing Assistant

CRNA Certifi ed Registered Nurse Anesthetist

DH Dental Hygienist

Dnt Dentist

EMT Emergency Medical Technician

NP Nurse Practitioner

OT Occupational Therapist

PA Physician Assistant

Phy Physician

PT Physical Therapist

RN Registered Nurse

RT Respiratory Therapist

5
• Click the Next button to display 

the next Lookup Wizard screen. 

• Ensure Client Type is entered as the 
label for the lookup column and 
that the Allow Multiple Values check 
box is NOT checked (Figure 3–28).

6
• Click the Finish button to 

complete the defi nition of the 
Lookup Wizard fi eld.

Why does the data type for the 
Client Type fi eld still show Text? 

The data type is still Text because 
the values entered in the wizard 
were entered as text. Figure 3–28

Finish button

label for 
lookup column

Allow Multiple Values 
check box (should not 
be checked)

Q
&

A

Multivalued Fields
If you plan to move your 
data to SQL Server at a 
later date, do not use 
multivalued fi elds. When 
you upsize a database 
containing multivalued 
fi elds to SQL Server, 
the fi eld is converted 
to a memo fi eld that 
contains the delimited 
set of values. This may 
mean that you need to 
do some redesign of your 
database.

B
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One client might need CNA, PA, Phy, and RN employees (Certifi ed Nursing Assistants, 
Physician Assistants, Physicians, and Registered Nurses). Another client might only need 
RTs (Respiratory Therapists).

To create a multivalued fi eld, create a Lookup fi eld being sure to check the Allow 
Multiple Values check box. The following steps create a multivalued fi eld.

1  Click the row selector for the Amount Paid fi eld, and then press the INSERT key to insert a 
blank row.

2  Click the Field Name column for the new fi eld, type Specialties Needed as the fi eld 
name, and then press the DOWN ARROW key. 

3  Click the Data Type column for the Specialties Needed fi eld, and then click Lookup Wizard 
in the menu of available data types to start the Lookup Wizard.

4  Click the ‘I will type in the values that I want.’ option button to indicate that you will type 
in the values.

5  Click the Next button to display the next Lookup Wizard screen.

6  Click the fi rst row of the table (below Col1), and then type CLS as the value in the fi rst row. 

7  Enter the remaining values from the fi rst column in Table 3–1. Before typing each value, 
press the TAB key to move to a new row.

8  Click the Next button to display the next Lookup Wizard screen. 

9  Ensure Specialties Needed is entered as the label for the lookup column.

10  Click the Allow Multiple Values check box to allow multiple values.

11  Click the Finish button to complete the defi nition of the Lookup Wizard fi eld.

To Save the Changes and Close the Table

The following steps save the changes; that is, it saves the addition of the two new 
fi elds and closes the table.

1  Click the Save button on the Quick Access Toolbar to save the changes. 

2  Click the Close ‘Client’ button.

TO MODIFY SINGLE OR MULTIVALUED LOOKUP FIELDS

You may fi nd that you later want to change the list of choices in a Lookup fi eld. If 
you fi nd you need to modify a single or multivalued Lookup fi eld you have created, you 
can use the following steps.
1. Open the table in Design view and select the fi eld to be modifi ed.
2. Click the Lookup Tab in the fi eld properties.
3. Change the list in the Row Source property to change the desired list of values. 

Modifying Table 
Properties
You can change the 
properties of a table 
by opening the table in 
Design view and then 
clicking the Property 
Sheet button on the 
Table Tools tab. Access 
will display the property 
sheet for the table. 
To display the records 
in a table in an order 
other than primary key 
order (the default sort 
order), use the Order By 
property. For example, to 
display the Client table 
automatically in Client 
Name order, click the 
Order By property box, 
type Client.Client Name 
in the property box, close 
the property sheet, and 
save the change to the 
table design. When you 
open the Client table 
in Datasheet view, the 
records will be sorted in 
Client Name order.

B
T
W

C6165_ACC_03.4c.indd   161C6165_ACC_03.4c.indd   161 3/7/07   9:51:12 AM3/7/07   9:51:12 AM



1
• Create a new query for the 

Client table.

• Click the Update button on the 
Design tab, double-click the 
Client Type fi eld to select the 
fi eld, click the Update To row in 
the fi rst column of the design 
grid, and then type MED as the 
new value (Figure 3–29).

Don’t I have to enter a criterion? 

If you only want the change to be 
made on some of the records, you 
would need to enter a criterion to 
identify those records. Without a 
criterion, the change will be made 
on all records, which is what you 
want in this update. 

AC 162   Access Chapter 3    Maintaining a Database

Figure 3–29

Design tab
Update button

Client Type 
fi eld included

Update To row 
added to design grid

Update To 
value (MED)

Q
&
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To Use an Update Query

The Client Type fi eld is blank on every record. One approach to entering the information for the fi eld would 
be to step through the entire table, assigning each record its appropriate value. If most of the clients have the same 
type, a simpler approach is available.

In the JSP Recruiters database, for example, most clients are type MED. Initially, you can set all the values 
to MED. To accomplish this quickly and easily, you can use an update query, which is a query that makes the same 
change to all the records satisfying a criterion. Later, you can change the type for dental organizations and labs.

The following steps use an update query to change the value in the Client Type fi eld to MED for all the 
records. Because all records are to be updated, criteria are not required.

Mass Changes
In some cases, rather than making individual changes to records, you will want to make 
mass changes. That is, you will want to add, change, or delete many records in a single 
operation. You can do this with action queries. An action query adds, deletes, or changes 
data in a table. An update query allows you to make the same change to all records 
satisfying some criterion. If you omit the criterion, you will make the same changes to 
all records in the table. A delete query allows you to delete all the records satisfying 
some criterion. You can add the results of a query to an existing table by using an append 
query. You also can add the results to a new table by using a make-table query.
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2
• Click the Run button on the 

Design tab to run the query and 
update the records (Figure 3–30).

Why don’t I click the View button 
to update the records? 

The purpose of the View button is 
to simply view results. The Run 
button causes the updates specifi ed 
by the query to take place. 

Why doesn’t the dialog box 
appear on my screen when I click 
the Run button? 

If the dialog box does not appear, 
it means that you did not choose 
the Enable this content option 
button when you fi rst opened 
the database. Close the database, 
open it again, and enable the 
content in the Microsoft Offi ce 
Security Options dialog box. Then, 
create and run the query again. 

I Experiment

• Create an Update query to change 
the client type to DNT. Enter a 
criterion to restrict the records to be 
updated, and then run the query. Open the table to view your changes. When fi nished, create and run an Update query 
to change the client type to MED on all records. 

3
• Click the Yes button to make the changes.
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Figure 3–30

Run button

Yes button

Microsoft Offi ce 
Access dialog box

message indicates 10 
rows will be updated

1. Right-click any open area in 
upper pane, point to Query 
Type on shortcut menu, 

click Update Query on 
Query Type submenu

Other Ways

Q
&

A
Q

&
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To Use a Delete Query

In some cases, you may need to delete several records at a time. If, for example, all clients in a particular postal 
code are to be serviced by another fi rm, the clients with this postal code can be deleted from the JSP Recruiters data-
base. Instead of deleting these clients individually, which could be very time-consuming in a large database, you can 
delete them in one operation by using a delete query, which is a query that will delete all the records satisfying the 
criteria entered in the query.

You can preview the data to be deleted in a delete query before actually performing the deletion. To do so, click 
the View button after you create the query, but before you run it. The records to be deleted then would appear in 
Datasheet view. To delete the records, click the View button again to change to Design view. Click the Run button, 
and then click the Yes button in the Microsoft Offi ce Access dialog box when asked if you want to delete the records.

The following steps use a delete query to delete any client whose postal code is 80412 without fi rst previewing 
the data to be deleted. (Only one such client currently exists in the database.)
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1
• Clear the grid. 

• Click the Delete button on the 
Design tab to make the query a 
Delete query (Figure 3–31).

• Double-click the Postal Code fi eld 
to select the fi eld.

• Click the Criteria row for the 
Postal Code fi eld and type 80412 
as the criterion.

Delete button

Design tab

2
• Run the query by clicking the Run 

button (Figure 3–32).

3
• Click the Yes button to complete 

the deletion. 

• Close the Query window. Do not 
save the query.

Figure 3–32

Run button

message indicates 1 
row will be deleted

Yes button

Microsoft Offi ce 
Access dialog box

Figure 3–31

Delete row added 
to design grid

postal code 
must be 80412

Postal Code 
fi eld included

Other Ways

1. Right-click any open 
area in upper pane, 
point to Query Type on 
shortcut menu, click 
Delete Query on Query 
Type submenu
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TO USE AN APPEND QUERY

An append query adds a group of records from one table to the end of another 
table. For example, suppose that JSP Recruiters acquires some new clients and a database 
containing a table with those clients. To avoid entering all this information manually, you 
can append it to the Client table in the JSP Recruiters database using the append query. 
To create an append query, you would use the following steps.
1. Create a query for the table containing the records to append.
2. In Design view, indicate the fi elds to include, and then enter any necessary criteria. 
3. View the query results to be sure you have specifi ed the correct data, and then return 

to Design view. 
4. Click the Append button on the Design tab. 
5. When Access displays the Append dialog box, specify the name of the table to receive the 

new records and its location. Run the query by clicking the Run button on the Design tab. 
6. When Access indicates the number of records to be appended, click the Yes button. 

TO USE A MAKE-TABLE QUERY

In some cases, you might want to add the records from an existing table to a new 
table, that is, a table that has not yet been created. If so, use a make-table query to add 
the records to a new table. Access will create this table as part of the process and add the 
records to it. To create a make-table query, you would use the following steps.
1. Create a query for the table containing the records to add.
2. In Design view, indicate the fi elds to include, and then enter any necessary criteria. 
3. View the query results to be sure you have specifi ed the correct data, and then return 

to Design view. 
4. Click the Make Table button on the Design tab. 
5. When Access displays the Make Table dialog box, specify the name of the table to 

receive the new records and its location. Run the query by clicking the Run button on 
the Design tab. 

6. When Access indicates the number of records to be inserted, click the Yes button. 

Validation Rules
You now have created, loaded, queried, and updated a database. Nothing you have done 
so far, however, makes sure that users enter only valid data. To ensure the entry of valid 
data, you create validation rules; that is, rules that a user must follow when entering the 
data. As you will see, Access will prevent users from entering data that does not follow the 
rules. The steps also specify validation text, which is the message that will appear if a user 
violates the validation rule.

Validation rules can indicate a required fi eld, a fi eld in which the user actually 
must enter data. For example, by making the Client Name fi eld a required fi eld, a user 
actually must enter a name (that is, the fi eld cannot be blank). Validation rules can make 
sure a user’s entry lies within a certain range of values; for example, that the values in the 
Amount Paid fi eld are between $0.00 and $100,000.00. They can specify a default value; 
that is, a value that Access will display on the screen in a particular fi eld before the user 
begins adding a record. To make data entry of client numbers more convenient, you also 
can have lowercase letters appear automatically as uppercase letters. Finally, validation 
rules can specify a collection of acceptable values; for example, that the only legitimate 
entries for the Client Type fi eld are MED, DNT, and LAB.

Using Wildcards in 
Validation Rules
You can include wildcards 
in validation rules. For 
example, if you enter the 
expression, like C?, in the 
Validation Rule box for 
the State fi eld, the only 
valid entries for the fi eld 
will be CA, CO, and CT.
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To Specify a Required Field

To specify that a fi eld is to be required, change the value for the Required property from No to Yes. The 
following steps specify that the Client Name fi eld is to be a required fi eld.

1
• Show the Navigation pane, and 

then open the Client table in 
Design view.

• Select the Client Name fi eld by 
clicking its row selector.

• Click the Required property box 
in the Field Properties pane, and 
then click the down arrow that 
appears. 

• Click Yes in the list (Figure 3–33).

What is the effect of this change? 

Users cannot leave the Client 
Name fi eld blank when entering 
or editing records. 

Q
&

A
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To Specify a Range

The following step specifi es that entries in the Amount Paid fi eld must be between $0.00 and $100,000.00. To 
indicate this range, the criterion specifi es that the amount paid value must be both >= 0 (greater than or equal to 0) 
and <= 100000 (less than or equal to 100000).

1
• Select the Amount Paid fi eld by 

clicking its row selector, click the 
Validation Rule property box to 
produce an insertion point, and then 
type >=0 and <=100000 as the rule. 

• Click the Validation Text 
property box to produce an 
insertion point, and then type 
Must be at least $0.00 and 

at most $100,000 as the text 
(Figure 3–34). 

What is the effect of this change?

Users now will be prohibited from 
entering an amount paid value 
that either is less than $0.00 or greater 
than $100,000.00 when they add records or change the value in the Amount Paid fi eld.  

Figure 3–34
validation text

validation rule

Amount Paid 
fi eld selected

Figure 3–33

Required property 
box arrowRequired 

property box 

Client table open 
in Design view

Client Name 
fi eld selected

value changed 
to Yes

Row selector 
for Client 
Name fi eld

Access automatically 
converts and to And
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To Specify a Default Value

To specify a default value, enter the value in the Default Value property box. The following step specifi es 
MED as the default value for the Client Type fi eld. This simply means that if users do not enter a client type, the 
type will be MED.

1
• Select the Client Type fi eld. Click 

the Default Value property box 
to produce an insertion point, 
and then type =MED as the value 
(Figure 3–35).

Client Type 
fi eld selected

Figure 3–35

default value
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To Specify a Collection of Allowable Values

The only allowable values for the Client Type fi eld are MED, DNT, and LAB. An appropriate validation 
rule for this fi eld prevents Access from accepting any entry other than these three possibilities. The following step 
specifi es the legal values for the Client Type fi eld.

1
• Make sure the Client Type fi eld is 

selected. 

• Click the Validation Rule property 
box to produce an insertion point 
and then type =MED or =DNT or 
=LAB as the validation rule. 

• Click the Validation Text property 
box and then type Must be MED, 
DNT, or LAB as the validation 
text (Figure 3–36).

What is the effect of this change? 

Users now will be allowed to 
enter only MED, DNT, or LAB in 
the Client Type fi eld when they 
add records or make changes to 
this fi eld. 

Figure 3–36

Validation Rule

Validation Text

Client Type 
fi eld selected

quotation marks added 
automatically by Access

Q
&

A
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To Specify a Format

To affect the way data appears in a fi eld, you can use a format. To use a format with a Text fi eld, you enter 
a special symbol, called a format symbol, in the fi eld’s Format property box. The Format property uses different 
settings for different data types. The following step specifi es a format for the Client Number fi eld in the Client 
table and illustrates the way you enter a format. The format symbol used in the example is >, which causes Access to 
display lowercase letters automatically as uppercase letters. The format symbol < causes Access to display uppercase 
letters automatically as lowercase letters.

1
• Select the Client Number fi eld. 

• Click the Format property box and 
then type > (Figure 3–37).

What is the effect of this change? 

From this point on, any lowercase 
letters will appear automatically as 
uppercase when users add records 
or change the value in the Client 
Number fi eld. 

Client numbers are supposed to be 
four characters long. Is there a way 
to ensure users don’t type more 
than four characters? 

Yes. The Field Size property 
dictates how many characters 
the users can type, so if you 
wanted to ensure that a maximum 
of four characters be allowed, you 
could change the fi eld size from 
255 to 4. 

Figure 3–37

Client Number 
fi eld selected

Field Size

Format

Q
&

A
Q

&
A
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To Save the Validation Rules, Default Values, and Formats

The following steps save the validation rules, default values, and formats.

1
• Click the Save button 

on the Quick Access 
Toolbar to save 
the changes 
(Figure 3–38).

2
• Click the No button 

to save the changes 
without testing 
current data. 

• Close the 
Client table.

Should I always 
click the No button 
when saving 
validation rules? 

If this were a 
database used to run 
a business or to solve 
some other critical 
need, you would 
click Yes. You would 
want to be sure that 
the data already in 
the database does 
not violate the rules.

Figure 3–38

No button

Microsoft Offi ce 
Access dialog box

message about 
data integrity rules

message about 
the process

Save button

Updating a Table that Contains Validation Rules
When updating a table that contains validation rules, Access provides assistance 

in making sure the data entered is valid. It helps in making sure that data is formatted 
correctly. Access also will not accept invalid data. Entering a number that is out of the 
required range, for example, or entering a value that is not one of the possible choices, 
will produce an error message in the form of a dialog box. The database will not be 
updated until the error is corrected.

Q
&

A

Changing Data Types
It is possible to change 
the data type for a fi eld 
that already contains 
data. Before you change 
a data type, however, 
you should consider 
what effect the change 
will have on other 
database objects, such 
as forms, queries, and 
reports. For example, 
you could convert a Text 
fi eld to a Memo fi eld 
if you fi nd that you do 
not have enough space 
to store the data that 
you need. You also could 
convert a Number fi eld 
to a Currency fi eld or 
vice versa.

B
T
W
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If the client number entered contains lowercase letters, such am49 (Figure 3–39), 
Access will display the data automatically as AM49 (Figure 3–40).

Figure 3–39

client number contains 
lowercase letters

Figure 3–40

letters automatically 
appear as uppercase

default value
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If the client type is not valid, such as xxx, Access will display the text message you 
specifi ed (Figure 3–41) and not allow the data to enter the database.

Figure 3–41

OK button

error message

invalid entry

Microsoft Offi ce 
Access dialog box

If the amount paid value is not valid, such as 125000, which is too large, Access also 
displays the appropriate message (Figure 3–42) and refuses to accept the data.

error message

invalid entry

Microsoft Offi ce 
Access dialog box

OK button

Figure 3–42
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To Use a Lookup Field

Earlier, you changed all the entries in the Client Type fi eld to MED. Thus, you have created a rule that will 
ensure that only legitimate values (MED, DNT, or LAB) can be entered in the fi eld. You also made Client Type 
a Lookup fi eld using a mass change. You can make changes to a Lookup fi eld by clicking the fi eld to be changed, 
clicking the arrow that appears in the fi eld, and then selecting the desired value from the list.

The following steps change the Client Type value on the third record to DNT and on the ninth record to LAB. 

1
• Open the Client table in Datasheet 

view and ensure the Navigation pane 
is hidden. 

• Click in the Client Type fi eld on the 
third record to display the arrow 
(Figure 3–44).

If a required fi eld contains no data, Access indicates this by displaying an error 
message as soon as you attempt to leave the record (Figure 3–43). The fi eld must contain 
a valid entry before Access will move to a different record.

Figure 3–43

OK button

error message

Microsoft Offi ce 
Access dialog box

When entering data into a fi eld with a validation rule, you may fi nd that Access 
displays the error message and you are unable to make the necessary correction. It may be 
that you cannot remember the validation rule you created or it was created incorrectly. In 
such a case, you neither can leave the fi eld nor close the table because you have entered 
data into a fi eld that violates the validation rule.

If this happens, fi rst try again to type an acceptable entry. If this does not work, 
repeatedly press the BACKSPACE key to erase the contents of the fi eld and then try to leave 
the fi eld. If you are unsuccessful using this procedure, press the ESC key until the record is 
removed from the screen. The record will not be added to the database.

Should the need arise to take this drastic action, you probably have a faulty valida-
tion rule. Use the techniques of the previous sections to correct the existing validation 
rules for the fi eld.

Figure 3–44

arrow

value to be 
changed
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2
• Click the down arrow to display 

the drop-down list of available 
choices for the Client Type fi eld 
(Figure 3–45).

Could I type the value instead of 
selecting it from the list? 

Yes. Once you have either deleted 
the previous value or selected the 
entire previous value, you can be-
gin typing. You do not have to type 
the full entry. When you begin with the 
letter, D, for example, Access will automatically add the NT. 

I Experiment

• Select the Client Type fi eld on the fi rst record. Try to change the client type by typing various values. 
Try to type an invalid Client Type (like SPT). When fi nished, change the value on the record to MED. 

Figure 3–45

list of available 
values

value to 
select (DNT)

Q
&

A

3
• Click DNT to change the value. 

• In a similar fashion, change MED 
on the ninth record to LAB 
(Figure 3–46). 

Figure 3–46

values 
changed

Figure 3–47

To Use a Multivalued Lookup Field

Using a multivalued Lookup fi eld is similar to using a regular Lookup fi eld. The difference is that when you 
drop down the list, the entries all will be preceded by check boxes. You then can check all the entries that you want. 
The appropriate entries are shown in Figure 3–47. As indicated in the fi gure, the specialties needed for client AC34 
are CNA, PA, Phy, and RN.
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The following steps make the appropriate entries for the Specialties Needed fi eld.

1
• Click the Specialties Needed fi eld 

on the fi rst record to display 
the arrow.

• Click the arrow to display the 
list of available specialties 
(Figure 3–48).

All the specialties currently appear 
in the box. What if there were too 
many specialties to fi t? 

Access would automatically 
include a scroll bar that you 
could use to scroll through all 
the choices. 

Figure 3–48

arrow
Specialties Needed fi eld 
on fi rst record selected

list of available 
specialties

check boxes 
to select

2
• Click the CNA, PA, Phy, and 

RN check boxes to select the 
specialties for the fi rst client 
(Figure 3–49).

Figure 3–49
OK button

selected 
specialties

Q
&

A

3
• Click the OK button to complete 

the selection.

• Using the same technique, 
enter the specialties given in 
Figure 3–47 on the previous 
page for the remaining clients 
(Figure 3–50).

Figure 3–50

all specialties 
entered
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To Resize a Column in a Datasheet

The Access default column sizes do not always allow all the data in the fi eld to appear. In some cases, the data may 
appear, but not the entire fi eld name. You can correct this problem by resizing the column (changing its size) in the datasheet. 
In some instances, you may want to reduce the size of a column. The State fi eld, for example, is short enough that it does not 
require all the space on the screen that is allotted to it. Changing a column width changes the layout, or design, of a table.

The following steps resize the columns in the Client table and save the changes to the layout.

1
• Point to the right boundary of the 

fi eld selector for the Specialties 
Needed fi eld (Figure 3–51) so that 
the mouse pointer becomes a 
doubled-ended arrow.

Figure 3–51

right boundary 
of fi eld selector

fi eld selector 
for Specialties 
Needed fi eld

mouse pointer shape 
indicates column can be 
resized by dragging or 
double-clicking

2
• Double-click the right boundary 

of the fi eld selector for the 
Specialties Needed fi eld to resize 
the fi eld so that it best fi ts the data 
(Figure 3–52).

Figure 3–52

column resized to 
best fi t the data

right scroll arrow
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3
• Use the same technique to resize 

all the other fi elds to best fi t 
the data. To resize the Amount 
Paid, Current Due, and Recruiter 
Number fi elds, you will need to 
scroll the fi elds by clicking the 
right scroll arrow shown in 
Figure 3–52 on the previous page 
(Figure 3-53).

4
• Save the changes to the layout by 

clicking the Save button on the 
Quick Access Toolbar.

• Close the Client table.

What if I closed the table without saving the layout changes? 

You would be asked if you want to save the changes. 

Figure 3–53

columns 
resized

Other Ways

1. Right-click fi eld name, 
click Column Width

Q
&

A

To Include Totals in a Datasheet

It is possible to include totals and other statistics at the bottom of a datasheet in a special row called the 
Total row. The following steps display the total of the commissions and the average of the rates for recruiters in 
the Total row. 

1
• Open the Recruiter 

table in Datasheet 
view and hide the 
Navigation pane.

• Click the Totals 
button on the Home 
tab to include the 
Total row in the 
datasheet 
(Figure 3–54).

Home tab
Totals button

Total row 
added

Recruiter 
table

Figure 3–54
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2
• Click the Total row in the 

Commission column to display 
an arrow.

• Click the arrow to display a 
menu of available computations 
(Figure 3–55).

Will I always get the same list? 

No. You only will get the items 
that make sense for the type of 
data in the column. You cannot 
calculate the sum of text data, for 
example. 

3
• Click Sum to calculate the sum of 

the commissions.

Figure 3–55

calculate average

Total row arrow 

Total row for 
Commission fi eld

no calculation

calculate variance

available 
computations

calculate standard 
deviation

fi nd largest value

fi nd smallest value

count records

calculate sum

Q
&

A

4
• Click the Total row in the Rate 

column to display an arrow.

• Click the arrow to display a menu 
of available computations.

• Click Average to calculate the 
average of the rates (Figure 3–56).

I Experiment

• Experiment with other statistics. 
When fi nished, once again 
select the sum of the commissions 
and the average of the rates. 

Totals button

average 
of rates

total of 
commissions

Figure 3–56
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To Remove Totals from a Datasheet

If you no longer want the totals to appear as part of the datasheet, you can remove the Total row. The following 
step removes the Total row. 

1
• Click the Totals button on the Home tab to remove the Total row from the datasheet.

Figure 3–57

Font Color 
button

Font Size boxFont box

Bold button

The changes to the datasheet will be refl ected not only on the screen, but also when 
you print or preview the datasheet.

Determine whether changes to the format of a datasheet are desirable.
You need to decide if changes to the format of a datasheet would improve its appearance 
and/or its usefulness. The following are the decisions you would make.

1. Would totals or other calculations be useful in the datasheet? If so, include the Total row 
and select the appropriate computations.

2. Would different gridlines make the datasheet more useful? If so, change to the desired 
gridlines.

3. Would alternating colors in the rows make them easier to read? If so, change the alter-
nate fi ll color.

4. Would a different font and/or font color make the text stand out better? If so, change 
the font color and/or the font.

5. Is the font size appropriate? Can you see enough data at one time on the screen and yet 
have the data be readable? If not, change the font size to an appropriate value.

6. Is the column spacing appropriate? Are some columns wider than they need to be? Are 
there some columns where not all the data is visible? If so, change the column size.

As a general guideline, once you have decided on a particular look for a datasheet, all 
your datasheets should have the same look, unless there is a compelling reason for one of 
your datasheets to differ.

Plan 
Ahead

Italic 
button

Align Text 
Left button

Align Text 
Right button

Alternate Fill/Back 
Color button

Center button

Gridlines 
button

Underline 
button

Fill/Back Color 
button

Changing the Appearance of a Datasheet
In addition to resizing columns and displaying totals, you can change the appearance of a 
datasheet in a variety of other ways. For example, you can change the appearance of grid-
lines or change the text colors and font. Figure 3–57 shows the various buttons, found on 
the Home tab, that are available to change the Datasheet appearance.

C6165_ACC_03.4c.indd   178C6165_ACC_03.4c.indd   178 3/7/07   9:51:55 AM3/7/07   9:51:55 AM



A
cc

es
s 

C
h

ap
te

r 
3Changing the Appearance of a Datasheet   AC 179

To Change Gridlines in a Datasheet

One of the changes you can make to a datasheet is which gridlines appear. You may feel that the appearance 
would be improved by having only horizontal gridlines. The following steps change the datasheet so that only 
horizontal gridlines are included.

1
• Open the Recruiter table in 

Datasheet view, if it is not 
already open.

• Click the box in the upper-left 
corner of the Datasheet selector 
to select the entire datasheet 
(Figure 3–58).

click to 
select entire 
datasheet datasheet 

selected

Figure 3–58

2
• Click the Gridlines button on the 

Home tab to display the Gridlines 
gallery (Figure 3–59).

Does it matter whether I click the 
button or the arrow? 

In this case, it does not matter. 
Either one will produce the 
same result. 

3
• Click the Gridlines: Horizontal 

command in the Gridlines gallery 
to include only horizontal 
gridlines.

I Experiment

• Experiment with other gridline 
options. When fi nished, once 
again select horizontal gridlines. 

Figure 3–59

Gridlines: Horizontal 
command (only 
horizontal gridlines)

Gridlines 
gallery

Gridlines 
button

Q
&

A
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To Change the Colors and Font in a Datasheet

You also may decide that you can improve the datasheet by changing the colors and the font. The following 
steps change the Alternate Fill color, a color that appears on every other row in the datasheet. They also change the 
font color, the font, and the font size.

1
• With the datasheet for the 

Recruiter table selected, click the 
Alternate Fill/Back Color button 
arrow to display the color palette 
(Figure 3–60).

Does it matter whether I click the 
button or the arrow? 

Yes. Clicking the arrow produces a 
color palette. Clicking the but-
ton applies the currently selected 
color. When in doubt, you should 
click the arrow. 

Font box arrow

aqua blue color (color to 
select for alternate fi ll)

Font Color 
button arrow

Alternate Fill//Back 
Color button arrow

red color (color you will 
select from Font Color  
palette for font color)

only horizontal 
gridlines included

Figure 3–60

Q
&

A

2
• Click Aqua Blue (the second from 

the right color in the standard 
colors) to select aqua blue as the 
alternate color.

• Click the Font Color arrow, and 
then click Red (the second color in 
the bottom row) in the lower-left 
corner of standard colors to select 
Red as the font color.

• Click the Font box arrow, and then 
select Bodoni MT as the font. (If it 
is not available, select any font of 
your choice.)

• Click the Font Size box arrow, 
and select 10 as the font size 
(Figure 3–61).

Does the order in which I make these selections make a difference? 

No. You could have made these selections in any order. 

I Experiment

• Experiment with other colors, fonts, and font sizes. When fi nished, return to the options selected in this step. 

Figure 3–61

font color changed

font changed font size 
changed

Datasheet Formatting 
arrow (brings up 
Datasheet Formatting 
dialog box)

alternate fi ll 
color changed

Q
&

A

font and font 
size changed

Font Color 
palette
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Using the Datasheet Formatting Dialog Box
As an alternative to using the individual buttons, you can click the Datasheet 

Formatting arrow, shown in Figure 3–61, to display the Datasheet Formatting dialog box 
(Figure 3–62). You can use the various options within the dialog box to make changes to 
the datasheet format. Once you are fi nished, click the OK button to apply your changes.

Figure 3–62

Gridline Color

Alternate 
Background Color

Datasheet Formatting 
dialog box

Background 
Color

option buttons 
for cell effects

Border and 
Line Styles

option buttons 
for direction

check boxes 
for gridlines

To Close the Datasheet Without Saving the Format Changes

The following steps show how to close the datasheet without saving the changes to 
the format. Because the changes are not saved, the next time you open the Recruiter table 
it will appear in the original format. If you had saved the changes, the changes would be 
refl ected in its appearance.

1  Click the Close ‘Recruiter’ button to close the Recruiter table.

2  Click the No button in the Microsoft Offi ce Access dialog box when asked if you want to 
save your changes.

Multivalued Field in Queries
You can use multivalued fi elds in queries just as you can use other fi elds. You have a choice 
concerning how the multiple values appear. You can choose to have them on a single row 
or on multiple rows.
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To Query a Multivalued Field Showing Multiple Values on a Single Row

To include a multivalued fi eld in the results of a query, place the fi eld in the design grid just like any other 
fi eld. The results will list all of the values for the multivalued fi eld on a single row, just as in a datasheet. The 
following steps create a query to display the client number, client name, client type, and specialties needed for all 
clients.

1
• Create a query for the Client table 

and hide the Navigation pane.

• Include the Client Number, Client 
Name, Client Type, and Specialties 
Needed fi elds (Figure 3–63).

Figure 3–63

position to click for 
Specialties Needed fi eld

multivalued fi eld (on 
any record, there may be 
more than one value)

single-valued fi elds 
(on each record, there 
is only one value)
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2
• View the results (Figure 3–64).

Can I include criteria for the multi-
valued fi eld? 

You can include criteria for the 
multivalued fi eld when all the en-
tries are displayed on a single row. 

I Experiment

• Return to Design view and enter 
various criteria in the Specialties 
Needed fi eld. Run the queries. 
When fi nished, return to the op-
tions selected in this step. 

Figure 3–64

multiple 
valuessingle 

values

Q
&

A

To Query a Multivalued Field Showing Multiple Values on Multiple Rows

You may be interested in those clients requiring a particular specialty, for example, those clients needing an 
RN. Unfortunately, you cannot simply put the desired specialty in the Criteria row just as you would with other 
fi elds. Instead you need to change the query so that each specialty occurs on a different row by using the Value 
property. Once you have done so, you can enter criteria just as you would in any other query.

The following steps use the Value property to display each specialty on a separate row.
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1
• Return to Design view and ensure 

the Client Number, Client Name, 
Client Type, and Specialties 
Needed fi elds are selected.

• Click the Specialties Needed fi eld 
to produce an insertion point, 
and then type a period and the 
word Value after the word, 
Needed, to use the Value property 
(Figure 3–65).

I don’t see the word, Specialties. 
Did I do something wrong? 

No. There is not enough room to 
display the entire name. If you 
wanted to see it, you could point 
to the right boundary of the col-
umn selector and then either drag 
or double-click. 

Do I need to type the word Value? 

No. You also can double-click the second Specialties Needed entry in the fi eld list. 

position to click for 
Specialties Needed.Value

Value 
property

only fi nal portion of 
fi eld name appears

Figure 3–65

Q
&

A
Q

&
A

2
• View the results (Figure 3–66).

Can I now include criteria for the 
multivalued fi eld? 

Yes. This is now just like any other 
query. There are no multiple 
values on any row. 

3

• Close the query by clicking the 
Close ‘Query1’ button.

• When asked if you want to save 
the query, click the No button.

Figure 3–66

Close ‘Query1’ 
button

each row contains 
only one specialty

The four specialties needed by 
client AC34 now appear on four 
rows. (In the previous query, they 
appeared on a single row.)

Q
&

A
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Referential Integrity
The property that ensures that the value in a foreign key must match that of another 
table’s primary key is called referential integrity. A foreign key is a fi eld in one table 
whose values are required to match the primary key of another table. In the Client table, 
the Recruiter Number fi eld is a foreign key that must match the primary key of the 
Recruiter table; that is, the Recruiter number for any client must be a recruiter currently 
in the Recruiter table. A client whose Recruiter number is 92, for example, should not be 
stored because no such recruiter exists.

In Access, to specify referential integrity, you must defi ne a relationship between 
the tables by using the Relationships command. Access then prohibits any updates to the 
database that would violate the referential integrity. 

The type of relationship between two tables specifi ed by the Relationships command 
is referred to as a one-to-many relationship. This means that one record in the fi rst table 
is related to (matches) many records in the second table, but each record in the second table 
is related to only one record in the fi rst. In the JSP Recruiters database, for example, a 
one-to-many relationship exists between the Recruiter table and the Client table. One 
recruiter is associated with many clients, but each client is associated with only a single 
recruiter. In general, the table containing the foreign key will be the many part of the 
relationship.

Identify related tables in order to implement relationships between the tables.
When specifying referential integrity, you need to decide how to handle deletions. In the 
relationship between clients and recruiters, for example, deletion of a recruiter for whom 
clients exist, such as recruiter number 21, would violate referential integrity. Any clients for 
recruiter 21 no longer would relate to any recruiter in the database. You can handle this in 
two ways. For each relationship, you need to decide which of the approaches is appropriate.

1. The normal way to avoid this problem is to prohibit such a deletion. 

2. The other option is to cascade the delete. This means that Access would allow the 
deletion but then delete all related records. For example, it would allow the deletion of 
the recruiter but then automatically delete any clients related to the deleted recruiter.

You also need to decide how to handle the update of the primary key. In the relationship 
between recruiters and clients, for example, changing the recruiter number for recruiter 21 to 
12 in the Recruiter table would cause a problem. Clients are in the Client table on which the 
recruiter number is 21. These clients no longer would relate to any recruiter. You can handle 
this in two ways. For each relationship, you need to decide which of the approaches is 
appropriate.

1. The normal way of avoiding the problem is to prohibit this type of update. 

2. The other option is to cascade the update. This means to allow the change, but make 
the corresponding change in the foreign key on all related records. In the relationship 
between clients and recruiters, for example, Access would allow the update but then 
automatically make the corresponding change for any client whose recruiter number 
was 21. It now will be 12.

Plan 
Ahead
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To Specify Referential Integrity

The following steps use the Relationships command to specify referential integrity by specifying a relationship 
between the Recruiter and Client tables. The steps also ensure that update will cascade, but that delete will not.

1
• Click Database Tools on the Ribbon 

to display the Database Tools tab 
(Figure 3–67).

Database 
Tools tab

Relationships 
button

Figure 3–67

2
• Click the 

Relationships button 
on the Database 
Tools tab to open the 
Relationships win-
dow and display the 
Show Table dialog 
box (Figure 3–68).

Client table

Add button

Close button

Recruiter 
table

Tables tab 
selected

Show Table 
dialog box

Relationships 
window

Figure 3–68
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3
• Click the Recruiter table and then 

click the Add button to add the 
Recruiter table. 

• Click the Client table and then 
click the Add button to add the 
Client table.

• Click the Close button in the Show 
Table dialog box to close the dia-
log box. 

• Resize the fi eld lists that appear so 
all fi elds are visible (Figure 3–69).

Do I need to resize the fi eld lists? 

No. You can use the scroll bars. 
Before completing the next step, 
however, you would need to 
make sure the Recruiter Number 
fi elds in both tables appear on 
the screen. 

Figure 3–69

Recruiter Number 
fi eld in Client table

Recruiter 
Number fi eld in 
Recruiter table

fi elds in 
Recruiter table

fi elds in 
Client table

Q
&

A

4
• Drag the Recruiter Number fi eld 

in the Recruiter table fi eld list to 
the Recruiter Number fi eld in the 
Client table fi eld list to open the 
Edit Relationships dialog box to 
create a relationship. 

Do I actually move the fi eld 
from the Recruiter table to the 
Client table? 

No. The mouse pointer will 
change shape to indicate you are 
in the process of dragging, but the 
fi eld does not move. 

• Click the Enforce Referential Integrity check box.

Q
&

A
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• Click the Cascade Update Related 
Fields check box (Figure 3–70).

The Cascade check boxes were 
dim until I clicked the Enforce 
Referential Integrity check box. Is 
that correct? 

Yes. Until you have chosen to 
enforce referential integrity, the 
cascade options have no meaning. 

Can I change the join type like I 
can in queries? 

Yes. Click the Join Type button in 
the Edit Relationships dialog box. 
Just as with queries, option 
button 1 creates an INNER join, 
option button 2 creates a LEFT  
join, and option button 3 creates a 
RIGHT join. 

Figure 3–70

Create button

Enforce Referential 
Integrity selected

Cascade Update 
Related Fields 
selected

Join Type button

Edit Relationships 
dialog box

Cascade Delete 
Related Records 
not selected

Recruiter Number 
fi elds used to 
relate tables

Figure 3–71

Save button

relationship line

“many” part of 
the relationship

“one” part of 
the relationship

Relationship 
Report button

one recruiter 
is related to 
many clients

Close 
‘Relationships’ 
button

Q
&

A
Q

&
A

Q
&

A
Q

&
A

5
• Click the Create button to 

complete the creation of the 
relationship (Figure 3–71).

What is the symbol at the lower 
end of the join line? 

It is the mathematical symbol 
for infi nity. It is used here to 
denote the “many” end of the 
relationship. 

Can I print a copy of the 
relationship? 

Yes. Click the Relationship Report 
button on the Design tab to pro-
duce a report of the relationship. 
You can print the report. You also 
can save it as a report in the data-
base for future use. If you do not 
want to save it, close the report 
after you have printed it and do 
not save the changes.  
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6
• Click the Save button on the Quick Access Toolbar to save the relationship you created.

• Close the Relationships window by clicking the Close ‘Relationships’ button. 

Can I later modify the relationship if I want to change it in some way? 

Yes. Click the Relationships button on the Database Tools tab. To add another table, click the Show Table button on the 
Design tab. To remove a table, click the Hide table button. To edit a relationship, select the relationship and click the 
Edit Relationships button. 

Effect of Referential Integrity
Referential integrity now exists between the Recruiter and Client tables. Access 

now will reject any number in the Recruiter Number fi eld in the Client table that does 
not match a Recruiter number in the Recruiter table. Attempting to change the recruiter 
number for a client to one that does not match any recruiter in the Recruiter table would 
result in the error message shown in Figure 3–72. Similarly, attempting to add a client 
whose recruiter number does not match would lead to the same error message.

error message

Microsoft Offi ce 
Access dialog box

no recruiter with this 
number exists in the 
Recruiter table

Figure 3–72

Q
&

A
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Access also will reject the deletion of a recruiter for whom related clients exist. 
Attempting to delete recruiter 21 from the Recruiter table, for example, would result in 
the message shown in Figure 3–73.

error message

Microsoft Offi ce 
Access dialog box

attempting to delete 
a recruiter for whom 
clients exist

Figure 3–73

Access would, however, allow the change of a recruiter number in the Recruiter 
table. Then it automatically makes the corresponding change to the recruiter number for 
all the recruiter’s clients. For example, if you changed the recruiter number of recruiter 21 
to 12, the same 12 would appear in the recruiter number fi eld for clients.

To Use a Subdatasheet

Now that the Recruiter table is related to the Client table, it is possible to view the clients of a given recruiter 
when you are viewing the datasheet for the Recruiter table. The clients for the recruiter will appear below the 
recruiter in a subdatasheet. The availability of such a subdatasheet is indicated by a plus sign that appears in front of 
the rows in the Recruiter table. The following steps display the subdatasheet for recruiter 24.

1
• Open the Recruiter table and hide 

the Navigation pane (Figure 3–74).

click to display 
subdatasheet 
for recruiter 24

+ sign indicates 
subdatasheet 
available

Figure 3–74
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2
• Click the plus sign in front of the 

row for Recruiter 24 to display the 
subdatasheet (Figure 3–75).

How do I hide the subdatasheet 
when I no longer want it 
to appear? 

When you clicked the plus sign, it 
changed to a minus sign. Click the 
minus sign. 

I Experiment

• Display subdatasheets for other 
recruiters. Display more than one 
subdatasheet at a time. Remove 
the subdatasheets from the screen. 

3
• Close the datasheet for the Recruiter table.

click to hide 
subdatasheet

subdatasheet 
for recruiter 24

+ sign changed 
to - sign

Figure 3–75

TO FIND DUPLICATE RECORDS

One reason to include a primary key for a table is to eliminate duplicate records. A 
possibility still exists, however, that duplicate records can get into your database. Perhaps 
the same client was inadvertently added to the database with a new client number. You 
can detect this type of redundancy by searching to see if any client’s names are duplicated. 
The Find Duplicates Query Wizard allows you to fi nd duplicate records. The following 
steps illustrate how to use the Find Duplicates Query Wizard to fi nd duplicate records.
1. Click Create on the Ribbon, and then click the Query Wizard button on the Create tab.
2. When Access displays the New Query dialog box, click the Find Duplicates Query 

Wizard and then click the OK button.
3. Identify the table and fi eld or fi elds that might contain duplicate information.
4. Indicate any other fi elds you want displayed.
5. Finish the wizard to see any duplicate records.

TO FIND UNMATCHED RECORDS

Occasionally, you may want to fi nd records in one table that have no matching records 
in another table. For example, you may want to determine which recruiters currently have 
no clients. The Find Unmatched Query Wizard allows you to fi nd unmatched records. 
The following steps illustrate how to fi nd unmatched records using the Find Unmatched 
Query Wizard.
1. Click Create on the Ribbon, and then click the Query Wizard button on the Create tab.
2. When Access displays the New Query dialog box, click the Find Unmatched Query 

Wizard and then click the OK button.
3. Identify the table that may contain unmatched records and then identify the related table.
4. Indicate the fi elds you want displayed.
5. Finish the wizard to see any duplicate records.

Q
&

A
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Ordering Records
Normally, Access sequences the records in the Client table by client number whenever listing 
them because the Client Number fi eld is the primary key. You can change this order, if desired.

2
• Click the Ascending 

button on the Home 
tab to sort the records 
by City (Figure 3–77).

What if I wanted the 
cities to appear in 
reverse alphabetical 
order? 

Click the Descending 
button. 

I Experiment

 Sort the records by city in 
reverse order. When done, sort the records by city in the original order. 

3
• Close the table. When asked if you want to save your changes, click the No button.

To Use the Ascending Button to Order Records

To change the order in which records appear, use the Ascending or Descending buttons. Either button 
reorders the records based on the fi eld in which the insertion point is located.

The following steps order the records by city using the Ascending button.

1
• Open the Client 

table in Datasheet 
view and hide the 
Navigation pane.

• Click the City fi eld 
on the fi rst record 
to select the fi eld 
(Figure 3–76).

Did I have to click 
the fi eld on the 
fi rst record? 

No. Any other record 
would have worked 
as well. 

Figure 3–76

City fi eld on fi rst 
record selected

Ascending 
button

Home tab

Descending 
button

Ascending button

records sorted 
alphabetically by city

Figure 3–77

Q
&

A
Q

&
A

Other Ways

1. Right-click fi eld name, 
click Sort A to Z (for 
ascending) or Sort Z to 
A (for descending) Special Database Operations

The special operations involved in maintaining a database are backup, recovery, compacting 
a database, and repairing a database. 
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Backup and Recovery
It is possible to damage or destroy a database. Users can enter data that is incorrect; 

programs that are updating the database can end abnormally during an update; a hard-
ware problem can occur; and so on. After any such event has occurred, the database may 
contain invalid data. It even may be totally destroyed.

Obviously, you cannot allow a situation in which data has been damaged or 
destroyed to go uncorrected. You must somehow return the database to a correct state. 
This process is called recovery; that is, you recover the database. 

The simplest approach to recovery involves periodically making a copy of the 
database (called a backup copy or a save copy). This is referred to as backing up the 
database. If a problem occurs, you correct the problem by copying this backup copy over 
the actual database, often referred to as the live database.

To backup the database that is currently open, you use the Back Up Database 
command on the Manage submenu on the Offi ce Button menu. In the process, Access 
suggests a name that is a combination of the database name and the current date. For 
example, if you back up the JSP Recruiters database on April 20, 2008, Access will suggest 
the name JSP Recruiters_2008-04-20. You can change this name if you desire, although it 
is a good idea to use this name. By doing so, it will be easy to distinguish between all the 
backup copies you have made to determine which is the most recent. In addition, if you 
discover that a critical problem occurred on April 18, 2008, you may want to go back to 
the most recent backup before April 18. If, for example, the database was not backed up 
on April 17 but was backed up on April 16, you would use JSP Recruiters_2008-04-16.

The following steps back up a database to a fi le on a hard disk or high-capacity 
removable disk. You should check with your instructor before completing these steps.

TO BACK UP A DATABASE

1. Open the database to be backed up.
2. Click the Offi ce Button, and then point to Manage on the Offi ce Button menu.
3. Click Back Up Database on the Manage submenu.
4. Select the desired location in the Save in box. If you do not want the name Access has 

suggested, enter the desired name in the File name text box.
5. Click the Save button.

Access creates a backup copy with the desired name in the desired location. Should 
you ever need to recover the database using this backup copy, you can simply copy it over 
the live version.

Compacting and Repairing a Database
As you add more data to a database, it naturally grows larger. When you delete an 

object (records, tables, forms, or queries), the space previously occupied by the object does 
not become available for additional objects. Instead, the additional objects are given new 
space, that is, space that was not already allocated. To remove this wasted space from the 
database, you must compact the database. The same option that compacts the database 
also repairs problems that may have occurred in the database.

TO COMPACT AND REPAIR A DATABASE

1. Open the database to be compacted. 
2. Click the Offi ce Button, and then point to Manage on the Offi ce Button menu.
3. Click Compact and Repair Database on the Manage submenu.

The database now is the compacted form of the original.

Quick Reference
For a table that lists how 
to complete the tasks 
covered in this book 
using the mouse, Ribbon, 
shortcut menu, and 
keyboard, see the Quick 
Reference Summary at 
the back of this book, 
or visit the Access 2007 
Quick Reference Web 
page (scsite.com/
ac2007/qr).

B
T
W

Certifi cation
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you 
to obtain a valuable 
industry credential—
proof that you have 
the Access 2007 skills 
required by employers. 
For more information, 
see Appendix F or 
visit the Access 2007 
Certifi cation Web page 
(scsite.com/ac2007/cert).

B
T
W

Compacting Error 
Message on Opening 
Database
If you open your 
database and receive a 
compact error message, 
you may not be able to 
view all the objects in 
your database. You also 
may not see your tables 
in tabbed windows. To 
redisplay all the objects 
in your database, click 
the Navigation pane 
arrow to display the 
Navigation pane menu. 
Make sure that Tables 
and Related Views is 
selected. To make sure 
that objects appear in 
tabbed windows, click 
the Microsoft Offi ce 
button, click the Access 
Options button, click 
Current Database, and 
make sure the Tabbed 
Documents option 
button is selected in 
the Application Options 
category.

B
T
W
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Additional Operations
Additional special operations include opening another database, closing a database 

without exiting Access, and saving a database with another name. They also include deleting 
a table (or other object) as well as renaming an object. Finally, you can change properties of 
a table or other object, such as the object’s description.

When you open another database, Access automatically will close the database that 
had been open. Before deleting or renaming an object, you should ensure that the object has 
no dependent objects, that is, other objects that depend on the object you wish to delete. 

The following steps describe how you could perform these operations.

TO OPEN ANOTHER DATABASE

1. Click the Offi ce Button.
2. Click Open on the Offi ce Button menu.
3. Select the database to be opened.
4. Click the Open button.

TO CLOSE A DATABASE WITHOUT EXITING ACCESS

1. Click the Offi ce Button.
2. Click Close Database on the Offi ce Button menu.

TO SAVE A DATABASE WITH ANOTHER NAME

1. Click the Offi ce Button.
2. Point to Save As on the Offi ce Button menu.
3. Select the Desired format.
4. Enter a name and select a location for the new version.
5. Click the Save button.

TO CHECK FOR DEPENDENT OBJECTS

1. Ensure that the object you wish to check is selected.
2. Click Database Tools on the Ribbon to display the Database Tools tab.
3. Click the Object Dependencies button on the Database Tools tab.
4. Click the ‘Objects that depend on me’ option button to display any objects that depend 

on the selected object.

TO DELETE A TABLE OR OTHER OBJECT

1. Right-click the object.
2. Click Delete on the shortcut menu.
3. Click the Yes button in the Microsoft Offi ce Access dialog box.

TO RENAME AN OBJECT

1. Right-click the object.
2. Click Rename on the shortcut menu.
3. Type the new name and press the ENTER key.

TO CHANGE OBJECT PROPERTIES

1. Right-click the object.
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2. Click Table Properties (if the object is a table) or Object Properties on the 
shortcut menu.

3. Change the desired property and click the OK button.

To Quit Access

You saved all your changes and are ready to quit Access. The following step quits Access.

1  Click the Close button on the right side of the Access title bar to quit Access.

 1. Create a Simple Form (AC 142)
 2. Use a Form to Add Records (AC 144)
 3. Search for a Record (AC 145)
 4. Update the Contents of a Record (AC 147)
 5. Delete a Record (AC 148)
 6. Use Filter By Selection (AC 149)
 7. Toggle a Filter (AC 151)
 8. Clear a Filter (AC 151)
 9. Use a Common Filter (AC 152)
 10. Use Filter By Form (AC 153)
 11. Use Advanced Filter/Sort (AC 155)
 12. Delete a Field (AC 157)
 13. Add a New Field (AC 157)
 14. Create a Lookup Field (AC 158)
 15. Add a Multivalued Field (AC 160)
 16. Save the Changes and Close the Table (AC 161)
 17. Modify Single or Multivalued Lookup Fields (AC 161)
 18. Use an Update Query (AC 162)
 19. Use a Delete Query (AC 163)
20. Use an Append Query (AC 165)
 21. Use a Make-Table Query (AC 165)
 22. Specify a Required Field (AC 166)
 23. Specify a Range (AC 166)
 24. Specify a Default Value (AC 167)
 25. Specify a Collection of Allowable Values (AC 167)
 26. Specify a Format (AC 168)
 27. Save the Validation Rules, Default Values, and 

Formats (AC 169)

 28. Use a Lookup Field (AC 172)
 29. Use a Multivalued Lookup Field (AC 173)
 30. Resize a Column in a Datasheet (AC 175)
 31. Include Totals in a Datasheet (AC 176)
 32. Remove Totals from a Datasheet (AC 178)
 33. Change Gridlines in a Datasheet (AC 179)
 34. Change the Colors and Font in a Datasheet (AC 180)
 35. Close the Datasheet Without Saving the Format 

Changes (AC 181)
 36. Query a Multivalued Field Showing Multiple Values 

on a Single Row (AC 182)
 37. Query a Multivalued Field Showing Multiple Values 

on Multiple Rows (AC 183)
 38. Specify Referential Integrity (AC 186)
 39. Use a Subdatasheet (AC 190)
 40. Find Duplicate Records (AC 191)
 41. Find Unmatched Records (AC 191)
 42. Use the Ascending Button to Order Records 

(AC 192)
 43. Backup a Database (AC 193)
 44.  Compact and Repair a Database (AC 193)
 45. Open Another Database (AC 194)
 46. Close a Database Without Exiting Access (AC 194)
 47. Save a Database with Another Name (AC 194)
 48. Check for Dependent Objects (AC 194)
 49. Delete a Table or Other Object (AC 194)
 50. Rename an Object (AC 194)
 51. Change Object Properties (AC 194)

Chapter Summary
In this chapter you have learned how to use a form to add records to a table; search for records; delete records; fi lter 
records; create and use Lookup fi elds; create and use multivalued fi elds; make mass changes; create validation rules; 
change the appearance of a datasheet; specify referential integrity; and use subdatasheets. The following list includes all 
the new Access skills you have learned in this chapter.

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.
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Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content. 

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions. 

Practice Test
A series of multiple choice questions that test your 
knowledge of chapter content and key terms. 

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter. 

Learn It Online

Test your knowledge of chapter content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and 
then enter the Web address scsite.com/ac2007/learn. When the Access 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

Apply Your Knowledge 

Reinforce the skills and apply the concepts you learned in this chapter.

Specifying Validation Rules, Updating Records, Formatting a Datasheet, and Creating 
Relationships
Instructions: Start Access. Open The Bike Delivers database that you modifi ed in Apply Your 
Knowledge in Chapter 2 on page AC 128. (If you did not complete this exercise, see your instructor for 
a copy of the modifi ed database.)

Perform the following tasks:
 1. Open the Customer table in Design view as shown in Figure 3–78.

Figure 3–78
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Continued >

 2. Format the Customer Number fi eld so any lowercase letters appear in uppercase and make the 
Customer Name fi eld a required fi eld.

 3. Specify that balance amounts must be between $0.0 and $1,000. Include validation text.

 4. Save the changes to the Customer table.

 5. Create a simple form for the Customer table and fi nd the record for ME71 and change the customer 
name to Mentor Group Limited. Save the form as Customer Simple Form and close the form.

 6. Open the Customer table in Datasheet view and use Filter By Selection to fi nd the record for CI76. 
Delete the record. Remove the fi lter.

 7. Resize all columns to best fi t and remove the gridlines from the datasheet. Save the changes to the 
layout of the table. Close the Customer table.

 8. Establish referential integrity between the Courier table (the one table) and the Customer table 
(the many table). Cascade the update but do not cascade the delete.

 9. Submit the revised database in the format specifi ed by your instructor.

Extend Your Knowledge 

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Creating Action Queries, Changing Table Properties
Instructions: See the inside back cover of this book for instructions for downloading the Data Files for 
Students, or see your instructor for information on accessing the fi les required in this book. 

Backyard is a retail business that specializes in products for the outdoors. The owner has created 
an Access database in which to store information about the products he sells. He recently acquired the 
inventory of a store that is going out of business. The inventory currently is stored in the Inventory 
database.

Perform the following tasks:
 1. The owner needs to add the items stored in the Product table of the Inventory database to the Item 

table of the Backyard database. Create and run an append query to create the Item table for the 
Backyard database shown in Figure 3–79.

Figure 3–79
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Extend Your Knowledge continued

 2. Open the Item table in the Backyard database and change the description for WF10 to Window 
Bird Feeder. Resize all columns to best fi t the data. 

 3. Sort the datasheet in ascending order by Description. 

 4. Add a totals row to the datasheet and display the sum of the on hand items, and the average cost 
and average selling price.

 5. Save the changes to the layout of the table. Close the table and rename it Product.

 6. Update the table properties for the Product table to include the description, Updated to include 
items from Inventory database.

 7. Using a query, delete all records in the Product table where the description starts with the letter S. 
Save the query as Delete Query.

 8. Change the database properties, as specifi ed by your instructor. Submit the revised database in the 
format specifi ed by your instructor.

Make It Right

Analyze a database and correct all errors and/or improve the design.

Correcting Table Design Errors
Instructions: Start Access. Open the Care4Pets database. See the inside back cover of this book for 
instructions for downloading the Data Files for Students, or see your instructor for information on 
accessing the fi les required in this book.

Care4Pets provides a variety of services to pet owners. The owner of Care4Pets has decided that 
she could better manage her business if she added a multivalued fi eld that lists the various types of pets 
her customers have. She created the fi eld shown in Figure 3–80 but forgot to add Rabbit as one of the 
pet types. Modify the multivalued Lookup fi eld to include Rabbit as a pet type.

Figure 3–80

Finally, she wanted to add referential integrity between the Groomer table and the Customer 
table. The relationship shown in Figure 3–81 is not correct and must be fi xed. She does not want to 
cascade the update or the delete.
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Continued >

Figure 3–81

Submit the revised database in the format specifi ed by your instructor.

In the Lab

Design, create, modify, and/or use a database following the guidelines, concepts, and skills 
presented in this chapter. Labs are listed in order of increasing diffi culty.

Lab 1: Maintaining the JMS TechWizards Database
Problem: JMS TechWizards is expanding rapidly and needs to make some database changes to handle 
the expansion. The company needs to know more about its clients, such as the type of business, and it 
needs to ensure that data that is entered is valid. It also needs to update the records in the database.

Instructions: Use the database created in the In the Lab 1 of Chapter 1 on page AC 67 for this 
assignment or see your instructor for information on accessing the fi les required for this book. 

Perform the following tasks:
 1. Open the JMS TechWizards database and then open the Client table in Design view.

 2. Add a Lookup fi eld, Client Type, to the Client table. The fi eld should appear after the Telephone 
Number fi eld. The fi eld will contain data on the type of client. The client types are MAN 
(Manufacturing), RET (Retail), and SER (Service). Save these changes to the structure.

 3. Using a query, change all the entries in the Client Type column to RET. Save the query as Client 
Type Update Query.

 4. Open the Client table and make the following changes. You can use either the Find button or Filter 
By Selection to locate the records to change:

a. Change the client type for clients AM53 and SA56 to MAN.

b. Change the client type for clients GR56, JE77, and ME17 to SER.

c. Change the name of client SA56 to Sawyer Industries.

d. Change the name of client ST21 to Steed’s Department Store.

 5. Resize all columns to best fi t the data and remove the vertical gridlines. Save the changes to the 
layout of the table.
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In the Lab continued

 6. Create the following validation rules for the Client table and save the changes.

a. Specify the legal values MAN, RET, and SER for the Client Type fi eld. Include validation text.

b. Assign a default value of RET to the Client Type fi eld.

c. Ensure that any letters entered in the Client Number fi eld appear as uppercase.

d. Specify that the billed amount must be less than or equal to $1,500.00. Include validation text.

 7. Open the Client table and use Filter By Form to fi nd all records where the client is located in 
Anderson and has a client type of SER. Delete these records.

 8. JMS has signed up a new retail store, Cray Meat Market (Client Number CR21) and needs to add 
the record to the Client table. The Meat Market is at 72 Main in Anderson, TX 78077. The phone 
number is 512-555-7766. Lee Torres is the technician assigned to the account. To date, they have 
not been billed for any services. Create a split form for the Client table and use this split form to 
add the record.

 9. Specify referential integrity between the Technician table (the one table) and the Client table (the 
many table). Cascade the update but not the delete.

 10. Compact the database and then back up the database.

 11. Submit the revised database in the format specifi ed by your instructor.

In the Lab

Lab 2: Maintaining the Hockey Fan Zone Database
Problem: The management of the Hockey Fan Zone store needs to change the database structure, add 
validation rules, and update records.

Instructions: Use the database created in the In the Lab 2 of Chapter 1 on page AC 68 for this 
assignment, or see your instructor for information on accessing the fi les required for this book. 

Perform the following tasks:
 1. Open the Hockey Fan Zone database and then open the Item table in Design view. 

 2. Add a Lookup fi eld, Item Type to the Item table. The fi eld should appear after the Description 
fi eld. The fi eld will contain data on the type of item for sale. The item types are CAP (caps and 
hats), CLO (clothing), and NOV (Novelties).

 3. Make the following changes to the Item table:

a. Change the fi eld size for the On Hand fi eld to Integer. The Format should be fi xed and the 
decimal places should be 0.

b. Make Description a required fi eld.

c. Specify the legal values CAP, CLO, and NOV for the Item Type fi eld. Include validation text.

d. Specify that number on hand must be between 0 and 75. Include validation text.

 4. Save the changes to the table design. If a dialog box appears indicating that some data may be lost, 
click the Yes button.

 5. Using a query, assign the value NOV to the Item Type fi eld for all records. Save the query as 
Update Query.

 6. Delete the split form for the Item table that you created in Chapter 1. The form does not include 
the Item Type fi eld. Recreate the split form for the Item table.
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 7. Use the split form to change the item type for item numbers 3663 and 7930 to CAP. Change the 
item type for item numbers 5923 and 7810 to CLO.

 8. Add the following items to the Item table.

3673 Blanket NOV 5 $29.90 $34.00 AC

6078 Key Chain NOV 20 $3.00 $5.00 MN

7550 Sweatshirt CLO 8 $19.90 $22.95 LG

 9. Create an advanced fi lter for the Item table. The fi lter should display the item number, item type, 
description, and number on hand for all items with less than 10 items on hand. Sort the fi lter by 
item type and description. Save the fi lter settings as a query and name the fi lter Reorder Filter.

 10. Resize all columns in the Item table and the Supplier table to best fi t. 

 11. Using a query, delete all records in the Item table where the description starts with the letter F. 
Save the query as Delete Query.

 12. Specify referential integrity between the Supplier table (the one table) and the Item table (the many 
table). Cascade the update but not the delete.

 13. Compact the database.

 14. Submit the revised database in the format specifi ed by your instructor.

In the Lab

Lab 3: Maintaining the Ada Beauty Supply Database
Problem: The management of Ada Beauty Supply has determined that some changes must be made to 
the database structure. A multivalued fi eld must be added. Validation rules need to be added. Finally, 
some additions and deletions are required to the database.

Instructions: Use the Ada Beauty Supply database created in the In the Lab 3 of Chapter 1 on page 
AC 69 for this assignment, or see your instructor for information on accessing the fi les required for 
this book. Submit the revised database in the format specifi ed by your instructor.

Instructions Part 1: Several changes must be made to the database structure. For example, management 
would like a multivalued fi eld that lists the type of services each beauty salon offers. This knowledge 
can help the sales representatives better meet the needs of their customers. Table 3-2 lists the service 
abbreviations and descriptions that management would like in a Services Offered multivalued fi eld.

Table 3–2 Service Abbreviations and Descriptions

Service Abbreviation Description

FAC Facial

HRS Hair Styling

MNC Manicure

PED Pedicure

MST Massage Therapy

TAN Tanning

Management wants to ensure that an entry always appears in the Customer Name fi eld and that 
any letters entered in the Customer Number fi eld appear in uppercase. It also requires that the amount 
in the Balance fi eld is never less than 0 or greater than $1,000. Make the changes to the database 
structure. Place the Services Offered fi eld after the Telephone fi eld.

Continued >
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In the Lab continued

Instructions Part 2: The data for the Services Offered fi eld shown in Figure 3–82 must be added to the 
database. The address for Elegante is incorrect. It should be 180 Broadway. Le Beauty has changed its 
name to Le Beauty Day Spa. Nancy’s Place has gone out of business. A new salon, PamperMe Day Spa, 
just opened. The address for the salon is 2125 Lawrence and the phone number is 555-2401. The spa 
provides all services except hair styling and tanning. 

Management wants to use PA10 as the customer number and Terry Sinson is the sales rep. The 
new spa has purchased $750 worth of supplies but has not paid for them. Format the datasheet to best 
fi t the data.

Figure 3–82

Instructions Part 3: Because the sales reps work on commission, management wants to make sure that 
customers are not assigned to a sales rep who is not in the database. It also wants the ability to change a 
sales rep number in the Sales Rep table and have the change applied to the Customer table. Create the 
appropriate relationship that would satisfy management’s needs.
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Continued >

Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution. 

• EASIER    •• MORE DIFFICULT

• 1: Maintaining the Second-Hand Goods Database
Use the Second-Hand Goods database you created in Cases and Places 1 in Chapter 1 on page AC 71 
for this assignment, or see your instructor for information on accessing the fi les required for this book. 
Perform each of the following tasks: 
 a. The Condition fi eld should be a Lookup fi eld. Only the current values in the database should be 

legal values.

 b. A better description for the bookcases is 3-Shelf Bookcase.

 c. The duvet has been sold.

 d. The minimum price of any item is $2.00. 

 e. It would be easier to fi nd items for sale if the default sort order for the item table were by 
description rather than by item number. Also, some of the descriptions are not displayed 
completely in Datasheet view.

 f. Specify referential integrity. Cascade the update and the delete.
Submit the revised database in the format specifi ed by your instructor.

• 2: Maintaining the BeachCondo Rentals database
Use the BeachCondo Rentals database you created in Cases and Places 2 in Chapter 1 on page AC 71 
for this assignment, or see your instructor for information on accessing the fi les required for this book. 
Perform each of the following tasks:
 a. Add the fi eld, For Sale to the Condo Unit, to indicate whether a condo unit is for sale. The fi eld is 

a Yes/No fi eld and should appear after the weekly rate.

 b. All units owned by Alonso Bonita are for sale.

 c. The Bedrooms, Bathrooms, and Sleeps fi elds always should contain data.

 d. Most common condo units have one bedroom, one bathroom, and sleep two people. All condo 
units should have a minimum of one bedroom, one bathroom, and sleep two people.

 e. No unit rents for less than $700 or more than $1,500.

 f. Management has just received a new listing from Mark Graty. It is unit 300. The unit sleeps 10, 
has three bedrooms, has 2.5 bathrooms, and includes linens. The weekly rate is $1,400 and the 
owner is interested in selling the unit.

Submit the revised database in the format specifi ed by your instructor.

•• 3: Maintaining the Restaurant Database
Use the restaurant database you created in Cases and Places 3 in Chapter 1 on page AC 71 for this 
assignment, or see your instructor for information on accessing the fi les required for this book. Using 
the Plan Ahead guidelines presented in this chapter, determine what changes need to be made to 
your database. For example, a multivalued fi eld could be useful to record opening days and times of 
a restaurant. Another multivalued fi eld could record restaurant specialties. Use a word processing 
program, such as Microsoft Word, to explain the changes you need to make to the database. Then, 
make the changes to the database. Submit the Word document and the revised database in the format 
specifi ed by your instructor.
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Cases and Places continued

•• 4: Updating Your Contacts Database

Make It Personal 
Use the contacts database you created in Cases and Places 4 in Chapter 1 on page AC 71 for this 
assignment, or see your instructor for information on accessing the fi les required for this book. 
Consider your own personal job situation. Has the focus of your job search changed? Are there specifi c 
jobs within the companies of interest that appeal to you? Have you contacted an individual within a 
company to express your interest? Create a multivalued fi eld to store those specifi c positions that would 
interest you. Review the fi elds in the contacts database. Are there any fi elds you need to add? Are there 
any fi elds you need to delete? Are there any tables that need to be deleted? Are there companies that 
need to be added to your database? Make any necessary changes to your database structure and update 
the database. Using a word processing program, such as Microsoft Word, explain what changes you 
made to your database and why you made the changes. Submit the Word document and the revised 
database in the format specifi ed by your instructor.

•• 5: Understanding Action Queries, Query Wizards, and Table Design Changes

Working Together 
With a make-table query, a user can create a new table from one or more tables in the database. The 
table can be stored in the same database or a new database. As a team, use the Access Help system 
to learn more about make-table queries. Then, choose either the Cases and Places 1 database or the 
Cases and Places 2 database and create a make-table query. For example, for the Hockey Fan Zone, 
the management could create a table named Supplier Call List that would include the item code, 
description, and cost of each item as well as the supplier name and telephone number. Write a one-
page paper that (1) explains the purpose for which the new table is intended and (2) suggests at least 
two additional uses for make-table queries. Submit the paper and the database in the format specifi ed 
by your instructor.

Open the Students database that you created in Chapter 1. As a team, review the data types for 
each of the fi elds that are in the database. Do any of these data types need to be changed? For example, 
is there a fi eld that should store multiple values? Are there any fi elds that should contain validation 
rules? Change the data types and add validation rules as necessary. Examine the tables in your database. 
Delete any tables that you do not need. Write a one-page paper that explains your reasons for changing 
(or not changing) the structure of the database. Submit the paper and the database in the format speci-
fi ed by your instructor.

Save the Ada Beauty Supply database as AdaTeam Beauty Supply. Research the purpose of the 
Find Unmatched Query Wizard and the Find Duplicates query Wizard. Use the AdaTeam database 
and create queries using each of these wizards. Did the queries perform as expected? Open each query 
in Design view and modify it, for example, add another fi eld to the query. What happened to the query 
results? Write a one-page paper that explains the purpose of each query wizard and describes the team’s 
experiences with creating and modifying the queries. Submit the paper and database in the format 
specifi ed by your instructor. 
 

C6165_ACC_03.4c.indd   204C6165_ACC_03.4c.indd   204 3/7/07   9:52:43 AM3/7/07   9:52:43 AM


